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Distribution Policy
The shareware version of Clip Master Pro may be distributed freely so long as the Copyright 
notice remains in tact, and that all files and documentation related to Clip Master Pro remain
unchanged from the original distribution. This specifically excludes the registration code 
which is non-transferable. Hermco Systems, Inc. assumes no liability and makes no 
warrantees implied or otherwise regarding the fitness of this product or it's compatibility 
with other software products. The user assumes full responsibility for it's installation and 
use.



How to Contact Us
We welcome all questions and comments regarding Clip Master Pro and can be reached via 
Email or at the address listed below. Be assured we will make every effort to respond to your
inquiry promptly.    

Please note that the operators at PsL take orders only - they cannot answer technical 
questions regarding Clip Master Pro, and are unable to put you in touch with the author. 
Their job is to process credit card orders and forward them to us. So please, only call the 800
number if you are going to register the product. Thanks.

CompuServe Email Address: 72772,1552
Internet Email Address: 72772.1552@compuserve.com

Hermco Systems, Inc. 
PO Box 556
New City, NY 10956



How to Register
You can register Clip Master Pro by credit card, by regular mail, or through CompuServe. The 
cost is only $22.95 for a single user license. This will entitle you to the enhanced 
commercial version of the program (the one without the built in sales pitch), as well as your 
first upgrade. For information on site licenses or multi-user discounts, please contact us by 
e-mail.

CompuServe

Registering with CompuServe is fast    and easy! No checks to write or letters to 
mail. Any time day or night. Just GO SWREG on CompuServe and look for SWREG 
ID 10043.

Credit Card  (Visa, Master Card, American Express, Discover)

You can register by credit card through the Public Software Library. Operators are on
duty Monday through Thursday from 7:00AM to 6:00PM CST and on Friday from 
7:00AM to 12:30PM. The toll free number is 800-242-4775. Alternatively, you can 
dial 713-524-6394. When you call, make sure to supply the correct product name 
and ID. These are Clip Master Pro and PsL Product ID 14458.

Please remember that the operators at PsL take orders only - they cannot answer 
technical questions regarding Clip Master Pro, and are unable to put you in touch 
with the author. Their job is to process credit card orders and forward them to us at 
Hermco Systems, Inc. If you have a problem with, or question about the product, 
please see the topic on How to Contact Us.                

You can also Email credit card orders to PsL at their CompuServe ID at 71355,470, 
or through the Internet at 71355.470@compuserve.com. Alternatively, you can 
Fax your order to 713-524-6398.

 When making an Email or Fax Order you must include the following information:

Name:
Email Address:
Phone:
Mailing Address:
Credit Card Type (Visa, Master Card, AMEX, Discover):
Credit Card #:
Expiration Date:
PsL Product ID: 14458
Product Name: Clip Master Pro
Number of Licenses: 

Also, please let us know where you downloaded the software from. Thanks.

Regular Mail

Please make your check out to Hermco Systems, Inc. and send it to the address that



follows. Be sure to include both your own mailing address and your Email address. 
Make sure to indicate the name of product you are registering (Clip Master Pro). 
Also, please let us know where downloaded the software from Thanks.

Hermco Systems, Inc.
PO Box 556
New City, NY 10956



Setup
You invoke the Clip Master Pro setup program from either the File Manager or the Program 
Manager    File Menu; more specifically the Run option. You will find it in the same directory 
as the file you just unzipped (for those users who receive a diskette from us directly, the 
setup program will be on the diskette). Once invoked, Setup will prompt you for a source 
directory specifying the directory it ran from as the default. It will also prompt you for a 
destination directory which defaults to c:\clipmstr. Setup will then copy the proper files to 
both the application and the windows\system    directories, and automatically create a 
Program Manager Group for Clip Master Pro. When you are finished, you may want to 
optionally copy the Clip Master Pro icon to your Program Manager Startup group so that it is 
activated automatically when you start Windows.



Getting Started with Clip Master Pro
When the application is first started, it runs invisibly in the background, 
automatically saving anything cut or copied to the clipboard. To make Clip 
Master Pro visible, simply type a Ctrl_V, and the Primary Window will appear 
with a complete list of clips to choose from. Just highlight the one you want 
and double click on it. Alternatively, clicking the right mouse button will 
invoke a Popup Menu containing the last 10 clipboard items (or less 
depending on what was saved), as well as a few special menu entries for 
jumping directly to the primary display, and for cutting and copying text from 
the current application. While holding down the right mouse button, just move
the mouse over the menu until the desired item is highlighted and then 
release it. 

The number of clips you can store simultaneously during a given session is limited only by 
the amount of memory you have available. However, the number of clips you can paste as 
an unregistered user is limited to the first 5 items in the clip list. To paste more items than 
these, you will need to register with the product with us.

In the event that Clip Master Pro intercepts keystrokes or clicks intended for another 
application or for the operating system itself, you can specify a different keystroke or click 
combination via the Configuration Window.

Please note that Clip Master Pro cannot be activated via a Paste command from the current 
applications Edit Menu. See the help topic on Activation Notes for details.



Configuration Window
The following attributes may be altered via the Configuration Window. To get there, just click 
on the Options menu of the primary display.

Print Screen

If set, this option causes the Print Screen key to route the current screen image directly 
to the printer, as well as save it to the clipboard. Note that when this option is not set, 
the screen is still saved, but not printed.

Reload on Startup

If set, this option causes the previous sessions clips to be reloaded automatically at 
startup. 

# Clips Saved

This value is the number of clips automatically saved at the end of each Windows 
session or when Clip Master Pro terminates. Note that a value of 0 or less indicates an 
unlimited number of clips. The default is 100.      

Main Activation

This section of the Configuration Window determines the key combination that activates 
the primary Clip Master Pro window. There are 3 options which are mutually exclusive: 
Ctrl_V,    Alt + Ctrl_V, and Ctrl_Ins. The default is Ctrl_V, which is the standard control key
for pasting from the clipboard for the great majority of    Windows applications. So for 
most users, the transition from pasting the old way to pasting with Clip Master Pro 
should be fairly natural. Only instead of just pasting the most recent contents of the 
clipboard, the user is presented with a complete list of clips to choose from. The 
alternate key combinations are provided in case there is a conflict with another 
application.

Popup Activation

This section of the Configuration Window determines the mouse click combination that 
activates the Popup menu for Clip Master Pro. There are 3 options which are mutually 
exclusive: Right Mouse Button, Ctrl + Right Mouse Button, and    Ctrl + Left Mouse 
Button. The default is the Right Mouse Button. The alternate click combinations are 
provided in case there is a conflict with another application. 

Registration Code

This is the field where you enter the registration code for enabling the commercial 
version of Clip Master Pro and disabling the shareware banner which is displayed on 
startup and on exit. Please note that the registration code is comprised of all upper case
characters and numbers. Also note that once the code is keyed in, it will not appear the 
next time the Configuration Window is displayed. This is normal.



Deleting Clipboard Items
A single clipboard item can be deleted by highlighting it in the primary Clip Master Pro 
display and then pressing the Delete key. In addition, the entire Clip Master Pro buffer can be
purged (deleting all items in the clip list), through a selection off    the Options menu.



Activation Notes
When Clip Master Pro is first started, it clears the contents of clipboard.

It is always resident in the backround, automatically saving text and graphics posted to the 
clipboard.

You will not actually see Clip Master Pro until you are ready to paste. 

Ctrl_V    and Right Mouse Click are the default activation methods for the main display and 
popup display respectively, and can be changed to one of the fallback methods via the 
Configuration Window. This should only be necessary if there is a conflict between Clip 
Master Pro and another application where they are both trying to intercept the same keys or 
clicks. See the help topic on Configuring Clip Master Pro for details.

Also, please note that while the above mentioned methods can activate Clip Master Pro, 
executing a Paste command from the Edit Menu of an applications menu bar will not. This is 
by design to insure that an application will be able to paste from the clipboard even if it does
not respond to Clip Master Pros internal paste commands. While the overwhelming majority 
of applications work seamlessly    with Clip Master Pro, there will always be a few that do not.
For these few applications a fail safe method of pasting must be provided. So the Edit Menu 
Paste command is reserved for this purpose. If you find this is the case with one of your 
programs, you can still use Clip Master Pro to populate the clipboard with an item from the 
clip list, but you will have to paste it into the application manually.



Entering the Registration Code
The registration code for enabling the commercial version of Clip Master Pro and disabling 
the shareware banner, can be entered through the Configuration Window. Please note that 
the registration code is comprised of all upper case characters and numbers. You will not be 
able see the characters or numbers    as you enter them, only asterisks to indicate their 
position. 



Primary Window
The primary Clip Master Pro display contains a list box which has an entry for each text or 
graphic item that has been posted to the clipboard, sorted from the top down in descending 
order. Each one of these entries has a clipboard format and an identifying caption which 
describes the clip, the form of which    varies according to its source.

If the clip was imported from a file directly into Clip Master Pro, then the {filename} in 
braces will be the identifying caption; if the clip is the result of pressing the Print Screen key,
then the identifying caption will read {screen capture}; if the clip is the result of a graphic 
being posted to clipboard by a Windows application, then the identifying caption will read 
{graphic or other non-text clipboard format}; and lastly, if the clip is the result of text being 
posted to the clipboard by a Windows application, then the identifying caption will be the 
body of that text (up to 128 characters depending on the size of the Clip Master Pro 
window). 

The identifying caption together with the clipboard format should be enough information to 
uniquely identify an    item in the clip list. Though occasionally it may be necessary to click 
on the View button to see the actual graphic or the entire body of text. To paste an item into 
the current application, double click on the desired entry or single click on the Paste button.

Command Buttons
 

File Open - activates a dialog to import a disk file into Clip Master Pro.

Paste - pastes the currently highlighted row in the clip list into the current application.

Paste Signature    - pastes the signature file into the current application.

Print - prints the currently highlighted row in the clip list.

View - activates the Clip Master Pro viewer for the currently hilighted row. 

Configure - brings up the Clip Master Pro Configuration Window. 

Help - brings up the on-line help for Clip Master Pro. 

Exit - Hides Clip Master Pro from view, but does not terminate the application.

Menu Commands

File

Open - imports a file from disk into the clip list (same as command button).

Save - writes the currently highlighted clip to disk.

Reload - All clips are automatically saved at the end of each session. Executing this 
command will reload any saved items to the current clip list in the event the automatic
reload is not set on the Configuration Window. 

Print - prints the currently highlighted item in the clip list.



Printer Setup - call the printer setup routine for the default printer.

Exit - hides Clip Master Pro in the background (same as command button).

Edit

Paste Clipboard - pastes the current contents of the Windows clipboard into the 
active application.

Paste Series - pastes all the items in the clip list in top down order.

Paste Tabbed Series - same as Paste Series, only inserts tab characters in between 
items.

Create Blank Entry - inserts blank text clip at the top of the clip list.

Paste Signature - Pastes the signature file into the active application. 

View Signature - View and Edit    the signature file. 

Options

Configure - invokes the Clip Master Pro Configuration Window.

Purge - initiates a purge of all the items in the clip list.



Popup Menu
The Popup display is a standard Windows Popup menu that contains a list of the last ten 
items that have been posted to the clipboard (or less depending on what was saved), as well
as a few special menu entries for jumping directly to the primary Clip Master Pro display, and
for cutting, copying, and pasting text. The list of clipboard items is sorted in the same order 
as the clip list on the primary Clip Master Pro display. Each item in the list has an identifying 
caption which describes the clip, the form of which    varies according to its source. If the clip 
was imported from a file directly into Clip Master Pro, then the {filename} in braces will be 
the identifying caption; if the clip is the result of pressing the Print Screen key, then the 
identifying caption will read {screen capture}; if the clip is the result of a graphic being 
posted to clipboard by a Windows application, then the identifying caption will read {graphic
or other non-text clipboard format}; and lastly, if the clip is the result of text being posted to
the clipboard by a Windows application, then the identifying caption will be the    body of that
text (up to 40 characters). If you need to see the entire body of text or the graphic 
associated with an identifying caption then you will have to first go to the primary display 
(one of the special menu entries), and then click on the View button. Please note that the 
Popup Window will not work when when either the primary ClipMaster Pro window is visible.

Additional Menu Items

Clip Master Pro - jumps to the primary Clip Master Pro display.

Cut - cuts the selected text from the active application and writes it to clipboard, as well 
as storing it in Clip Master Pro.

Copy - copies the selected text from the active application and writes it to clipboard, as 
well as storing it in Clip Master Pro.

Paste Clipboard - pastes the current contents of the Windows clipboard into the active 
application.

Paste Series - pastes all the items in the clip list in top down order.

Paste Tabbed Series - same as Paste Series, only inserts tab characters in between 
items.

Paste Signature - Pastes the signature file into the active application. 



Viewer Window
The Clip Master Pro Viewer is activated from the primary display by clicking on the View 
button. It allows the user to look at the complete graphic or the entire body of text 
associated with the selected item, as well as edit that item provided it is character based. 
Note that text clips which exceed approximately 32K are temporarily truncated for viewing 
purposes and may not be edited (though they are restored to their original size when 
pasting). Also note that a wrap feature has been provided for long paragraphs that scroll too 
far off to the right.

Command Buttons

Prev - view the previous entry in the clip list.

Next - view the next entry in the clip list.

Paste - pastes the currently clip into the current application.

Print - prints the contents of the Clip Master Pro View Window on the default printer.

Help - brings up the on-line help for Clip Master Pro. 

Exit - closes the Clip Master Pro Viewer.

Menu Commands

File

Save - writes the current clip to disk.

Print - prints the currently highlighted item in the clip list.

Printer Setup - call the printer setup routine for the default printer.

Exit - closes the Clip Master Pro Viewer.

Edit

Cut - cut currently hilighted text from edit window

Copy - copy currently hilighted text from edit window.

Wrap - wrap text on/off.



Memory Usage and Constraints
The number of items that Clip Master Pro can maintain during a given Windows session is 
limited only by the amount of available memory at runtime. If you are cutting and copying 
small blocks of text (under 500 bytes), you can store hundreds of items or more. Though 
obviously if you are cutting and copying graphics (with an average size of 250K), the number
of items you can store will be dramatically reduced. Also, the amount of memory available to
Clip Master Pro may change according to the number of tasks you are simultaneously 
running and the amount memory these tasks collectively require.

While you can store many blocks of text, there is a maximum text length of approximately 
64K for any single block. If you exceed this limit while cutting or copying text, or while 
importing a text file into Clip Master Pro, a warning message will be displayed. Further, text 
clips which exceed approximately 32K are temporarily truncated for viewing purposes and 
may not be edited. These clips however, are restored to their original size when pasting. 
Note that these limitations do not apply to graphics. 



Pasting Formatted Text
While Clip Master Pro can save text from a program like Microsoft Word, it cannot save the 
corresponding font attributes that go with it (fontname, fontsize, bold, underline, etc.). That 
is because the clipboard formats that support font attributes are dependent on a dynamic 
link between the data in the clipboard and the application that put it there. This relationship 
is often proprietary and once the data in the clipboard changes or the owner application 
terminates, the associated attributes are lost. The text however, is maintained there after in 
standard ascii format, which is how it is saved.

Clip Master Pro does however provide a method by which you can paste the current contents
of the clipboard, and if it happens to contain formatted text, then that formatted text will be 
pasted too. But this data changes whenever something new is cut or copied to the clipboard 
- note that it also changes whenever pasting a clip from Clip Master Pro. So what does this 
mean? Basically that we simulate the current applications paste command which pastes 
data directly from the clipboard. You will see a Paste Clipboard menu entry under both the 
Edit menu on the primary display and on the popup menu.



Clipboard Formats
The following is a list of standard clipboard formats that are common to all applications. In 
addition to these, there are many private formats which individual applications such as 
Microsoft Word and Microsoft Excel use unto themselves (cutting and pasting within the 
same application or class), and thus are not available to other applications. The ones set in 
bold are the formats Clip Master Pro is capable of saving.

CF_BITMAP
The data is a bitmap. 

CF_DIB
The data is a device independent bitmap. 

CF_DIF
The data is in Data Interchange Format (DIF). 

CF_DSPBITMAP
The data is a bitmap representation of a private format. This data is displayed in 
bitmap format in lieu of the privately formatted data. 

CF_DSPMETAFILEPICT
The data is a metafile representation of a private data format. This data is displayed 
in 
metafile-picture format in lieu of the privately formatted data. 

CF_DSPTEXT
The data is a textual representation of a private data format. This data is displayed in
text format in lieu of the privately formatted data. 

CF_METAFILEPICT
The data is a metafile format. 

CF_OEMTEXT
The data is an array of text characters in the OEM character set. Each line ends with 
a 
carriage returnlinefeed (CR-LF) combination. A null character signals the end of the 
data. 

CF_OWNERDISPLAY
The data is in a private format that the clipboard owner must display. 

CF_PALETTE
The data is a color palette. 

CF_PENDATA
The data is for the pen extensions to the Windows operating system. 

CF_RIFF
The data is in Resource Interchange File Format (RIFF). 

CF_SYLK
The data is in Microsoft Symbolic Link (SYLK) format. 



CF_TEXT
The data is an array of text characters. Each line ends with a carriage returnlinefeed 
(CR-LF) combination. A null character signals the end of the data. 

CF_TIFF
The data is in Tag Image File Format (TIFF). 

CF_WAVE
The data describes a sound wave. This is a subset of the CF_RIFF data format; it can 
be used only for RIFF WAVE files. 



Paste Series & Paste Tabbed Series
These two functions facilitate the simultaneous pasting of all the items in the clip list. They 
can be found off of the Edit menu on the primary display and on the Popup menu as well. 
The only difference between them is that the Paste Tabbed Series function inserts a tab 
character in between the individual items as they are being pasted, thus making it possible 
to populate multiple fields on a form with a single click or keystroke. This can be extremely 
useful in doing repetitive data entry. Just position the cursor on the first field you wish to 
paste and let Clip Master Pro do the rest. It will automatically paste the first item in the clip 
list, then tab to the next field, then paste the next item in the list, and so on. The Paste 
Series functions are also useful for concatenating multiple clips into a single document or 
text file. They are however limited in the sense that you must paste all items in the list, not 
just a selected few. To this end, there are several features of Clip Master Pro that are 
designed to support the Paste Series functions. One is the ability to rearrange the order of 
the clip list so you dont have to worry about the order in which you cut and copy items, and 
the other is the ability to insert blank rows so that you can skip over fields you dont wish to 
paste.

To rearrange the order of the clip list, simply hold down the left mouse button and drag the 
item to its new position in the list.

To insert a blank row in the clip list, use the Create Blank Row command off the Edit menu on
the primary Clip Master Pro display. Note that once a blank entry is created, it can be edited 
in the Viewer Window if necessary. Therefore, this feature can be used to create new text 
items as well as to support the Paste Series functions.

Please note that the shareware version of Clip Master Pro allows pasting of only the top five 
items in the clip list, and this restriction includes the Paste Series functions.



Trouble Shooting
1. This program requires vbrun300.dll which we do not distribute with our application. If 
you don't already have this file in your c:\windows\system    directory, you can download it 
from the MSBASIC forum on CompuServe, or if you like we can send you a special Clip 
Master Pro distribution file which contains it. Also, there are certain other .dll files which are 
normally found in the c:\windows\system    directory that are needed by Clip Master Pro. 
They are commdlg.dll, and toolhelp.dll. If for some reason these files are not there, you can 
restore them from your Windows distribution media, or if you like we can send you a special 
Clip Master Pro distribution file which contains them. 



Signature File
The Signature file is a special text entry that you can edit to include a closing greeting, your 
name, address, or a tag line that you commonly use. For example, you might populate it 
with your name, address, and telephone number, to use in all your electronic 
correspondence. Or you might just make a thought for the week. Which ever the case, once 
the text is entered, you just use the Paste Signature function to insert it into the active 
application. Note that this is not part of the regular clip list. It is automatically loaded at 
startup and saved when Windows or Clip Master Pro terminates. Also note that while the 
Signature file can be modified at any time, it cannot be deleted. To edit the file, use the View
Signature function off the Edit Menu on the main Clip Master Pro window. 




